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1.3

INTRODUCTION

The Provincial Plan for the Provinee of Sonthern Leyle

1.3.2 Outline of the Repord

Table 1.3.1

1ist of Collected Reports and Documents

Wo. T Tl o Year Source . _JGJ C NMTE]
I I GENERAL . = e o
1. |Tke Philippine National Developamwent Plan

Program Master Planning 1958 NEDA =
2. {Repon and Recommendation of the President to
the Board of Directors on Proposed Loans to the
Republic of the Philippines for the Rural Water
Supply and Sanitation Sector Project May 1996 ADB -
3. |Repont and Recommendation of the President to
the Board of Mirectors on a Proposed Loan to the
Republic of the Philippines for the Reghonal
Municipal Pevelopment Project Aug. 1995 ADPRB -
4. [Long Term and Modivm Temm Sector Dev't.
Phanning Workshop No. 2 1998 DILG
5. |Philippine Agenda - A National Agenda for
Sustainable Development for the 21st Century 1997 PCSD -
6. |Updated Medivm-Tean
Phitippine Development Plan 1996 - 1998 Dec. 1995 NEDA n
7. |Water Supply, Sewerage and Sanitation
Master Plan of the Phitippines 1988 - 2000 1938 NEDA [}
8. [Catalogue Products and Services 1993 NAMRIA ]
9. | The Philippines in 1995: Our Time Has Come Junz 1995 op ]
10. JAustratian Development Comporation with the
Philippines - Philippine Program Profite
{Section C.3) July 1997 LGU
I 1. [Social Reformy Agenda Policy Directives Social Reform -
Council Sceretariat
ir. 3 U SOCIOECONOMIC o o D e T
1. [Socio-Economic Profite (Southern Leyie) PPDO
2. |Censvs-Based National and Regional Population
Projection Volume | ‘ 1995 NSO L
3. [Report No. t-P: Population by Province, City/
Municipality and Barangay :
Region Viki 1995 Census 1995 NSO
4. |Report No. 2-87F: Socio Econeinic and
Demographic Characteristics Souther Leyte i
1995 Census ' Junc-05 NSO
5. |Philippine $tatistical Yearbook 1997 NSCH n
6. |NSO Cersus by Province, Male, Female and :
Age Bracket 1995 NSG




TN I ) (| i JELCTRT P TS H]
7. [Geographic Coding and Urban and Rural
Classification (Region V1) 1990 NSO =
8. [Total Poputation, Household Population and
Nuiober of Houscholds by Province, City!
Municipality and Barangay 1995 NSO -
HL | oo WATERSOURCE -~ | T
1. |Master Plan Study on Water Resources
Manageoment in Republic ofthe Philippines Vo, [ Jan. 1998 NWRD -
2. [Masters Plan Study on Watee Resources
Maznageinent in Republic of the Philippines Vol It Jan. 1998 NWRB L
3. |Phitippine Water Resources Data Volume [
Streamflow and Lake or River Stage Jan. 1980 NWRC -
4. |Philippine Water Resources Data Volume It
Streamiflow and Iake or River Stage June 1991 DPWH-BRS n
5. [Master Flan Stedy on Water Resources
Management dn the Repablic of the Philippines July 1997 NWRD L
6. |Vopographic Maps 1:250,000 Reprinted in
Southern § eyie 01,93 and 95 NAMRIA -
7. [Rapid Assessawat of Water Supply Sources 1982 NWRB =
Sovthern Leyte
8. [Groundwaicr Resources Investigation Report Unpublished NWRB »
Southern Leyte
9. |Water Resources Summary Data
{(Volume 1 and 2) 1970 NWRDB L]
10, {Indwidual Well laventory 1990 NWRB =
Southern Leyte
11 {Groundwater of the Phitippines June 1980 NWRC =
12, {LWUA Water Pristrict Database 1997 LWUA L
13, |Road Network Map -
14. [Well Inventory NWRB L
15. |Well inventory 1998 DPWH-DEO u
16. |Well Drilling Record 1998 DPWH-DEO u
o WATERSUPPLY v T T ! S
1. JAssessment of the Domestic WS and Sanitation :
Sector of Eastern Visayas April-98 NEDA/UNIFEC =
2. |Technical Assistance to the Republic of the -
Philippines for the Waicr Supply and Saritation
Sector and Study Suly 1997 ADB . =
3. [Working Group on Urbanization {(WG/U) of the
Water Supply and Sanitation Collaborative ' ‘ o
Council (WSCC) Sept. 1993 WSCC-WGAU =
4. |Water Suppy Frasibility Swdy Mclhodology )
.’\-1;nua1 {LWUA-Mala Columbus) 1996 o LWUA -
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I . e _ 7 Year [

5. |Overview of Water Pricing Policics amd Structures
m the ESCAP Region 1596 LiN

6 |Reportand Recomniendation of the President to Scpt 1996 ADDG
Board of Dirzctors on a Proposed Lean (0 the
1.WUA in the Republic of the Philippines for the
Srnatl Towns Water Supply Sector Project

| ¥ I ENVIRONMENTAL SANITATION

1. | Trainer's Training Kits for Sandtation Mar. 1996 UNDPODINLG

2. |¥cological Alternatives in Sanitation Aug. 1997 SIDA

3. |ihe Code Sanitation of the Phitippines 1876 BOH

VL CINSTIFUTIONAL

1. {General Primee - Local Government Code of 1931 1921 DILG

2. | The Barangay and the Local Governanent Code 1994 DG

3. INEDA Board Resolution No. 4 (5. 1994) 1994 NEDA

4. |Implementing Rules and Regulations of
NEDA Doard Resolution No. 4 {8. 1994),

Clause {G) Nov. 1997 NEDA

5. |NEDA Board Resolution No. 5, §-24 1994 NEDA

6. |NEDA Board Resolution No. 5, 5-26 1996 NEDA

7. INEDA Boardl Resolution Ro. 5, 5-5% 1989 NEDA

VIL | L COMMUNITY DEVELOPMENT - P

1. |Cemmunity Development Manual DPWHVDILG
Fisst Water Supply, Scwerage and Ssritation LWUA/GON
Seciors Projects (FWASP)

2. |BWSA Formulation Operations Maneal DPWH/DILG!
Community Development Maneai LWUADOH
First Water Supply, Sewerage and Sanitation
Sectors Projects (FW4SP)

3. Hnstitwtion Building for Decetralized luplemerntation
of Community-Managed Water Supply and
Sanitation Projects DILG

4. |institution Building for Decentralized Implement-
ation of Community-Managed Water Supply
and Sanitation Projects June 1997 DILG

5. lGuidebook for Communily Maraged WATSAN
Project UNDP

6. |A Manual for Tra.im'ng Teainers in Participatory PROWWESS’
Techniques | 1950 UNDP

7. |taterception Report for Special Assistance for
Projects Sustainability for the Rural Warer Supply
111 Project i 1997 SAPS Feam

8. ln!en'.m Repori for Special Assistance for Projects
Sustainability for the Rural Water Supply Hi )
Project (SAP3) 1997 SAPS Teamy




(No. | TR "

B AGICIRI P | M
9. [Participatory Action Planping for the Develapment e

of Two PSE Peoject 1994 vp
10. |Water and Sanitation for AN A World Priority 1595 IRC International -
Achicvemeats and Challenges Water & Social Ceater
11, [Community Organizers' Manual, Past ] 1990 CSWOD-UPDCDY
DOPS
12. A Handbook on Comimunity Development 1975 UpP =
13. {Achieving Success in Communily Waler Supply UNDP -

and Sanilation Projocts

14, |Handbook on Comnuaily Organizing for Water DILG =
Sanitation

5. 1Dcafl Final Repont for Special Assistance for
Projects Sustainability for the Rural Water Supply
14 Project Teb. 1997 SAPS Team [ ]

16, 1A Manual on Commenity Participation in Wates n
Supply and Sanftation {R\WSSP)

17. |Achieving Success in Community Water Supply and

Sanitation Projects 1980 WO -
18. |Community Development Manual Nov. 1995 nc u
VI o o S UGENDER o sy e S T T e T

1. |Scurcebook for Gender Issues at the Policies Level
in the Water and Sanitation Sccior Oct 1996 IBROW -

2. |Gender tssues Sourcebook for Water and Sanitation

Projects Jan 1993 IBROMWE |
3. {Toolkiton Gender in Water and Sanitation
Series No. 2 Aug. 1996 UNDP -
4. [Domestic Shatlow Well Water Supplics the Famity
Handpamp Szenario Feb. 1990 URBP -
5. |United Nations Precade for Women 1976-1985 -
6. |Gender Mainstreaming NCRFW ]
7. |Regionat Mosmorandums Feb. 1997 DILG -
8. |Philippine Plan for Gendar Developmicnt 19952025 N(‘P{FW ]
9. [Phitippine Country Report on Women Sept. 1995 NCRFW L
10. JA Prinicr o the GAD I-‘.ocal Paint 1990 NCRFW . -
IX ceilno o SO FINANCIAL e o T T T T i
1. |Anunueal Invesiment Plans, Southem Leyte FPDO ' (]
2. |Family lncome and Exgenditures Sunvey Vol. | 1994 N3O a
3. |Fanuly Incomwe and Expenditures Survey Vol. Il I £V ‘ .NSO "
4. DG Menwrandwﬁ Circular 96-263 1996 ' DI[.G ' u

5. YPresidential Decrce 1914 (MDF) : 1984 op |




- e T dGl e R PIM]BY
“Troiat Cheutar No. 6-87 Aug. 1987 4
7. |ieyteAccomplishment Repants,
§993-1996 1993-1996 PPDO n
\9 g |Statement of Income-Expenditures
i of Municipalities PPDO [
fegerd:
ADB - Asian Developuent Bark
BRC - Bureau of Research and Standards PIC .« Pzoject Fmptementation Consubiants
CSWCD - College of Social Work and Community Dewclopinent PPDO - Provingial Plaaning and Developiaent Office
DCO - Deparbnent ef Community Develaprent PROWWESS - Promation of the Role of Wonen in Water,
DED - District Enginees Oltice Envirpnmenial and Sanitation Sourges
DG - Departme at of Intericr and Local Govemment SIDA - Snedish fnternational Developiment Cooperation Agency
DO - Departient of Health UN - United Nasions
POFL - Deselopment Options Phitippines, fic. UNIFEC - United Nations Liternational Chillren's Fund
DPWH - Department of Works and Highways UNDP - Linfted Nations Devefopment Project
IBRD - Intermanional Bank for Reconstruction and Bevelopment UP - Univessity of the Philippines
LGU - Local Govemment Unit WATSAN - Water and Sanitation
LWUA - Local Water Utilities Administration WB - World Bask
NAMRIA - National Mzappiog & Resource Isfonnation Authority WHO - World Heahth Oryanization
NCRFW - National Commission in the Rode of Fikiping Women WSOC-WG/L « Water Supply & Sanitation Colleborative
NEDA - Natiopal Economic Development Autharity Cowncil-Working Group on Urbanization
NSCB - Mational Statistical Coordination Board G - Gloha)
NS0 - Nationat Statistics Office C - Central Govemment Level
NWRAE - National Water Resource Busean R - Regional Govenment Level
NWRC - National Water Resource Council P - Provincial Level
OPF - Oftice of the President 84 - Municipal f.evel
PCSE - Philippine Counsel for Sustainable Developiment B8 - Barangay Level
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Aunex | User’s Guide for Computer-Aided Planning

. INTRODUCTION

‘The PWASP Data Management User's Guide explains the procedure of encoding data and generating
tables and figures for the PWASP, The Guide consists of the following sections.

Section 2: hardware and soflware required to succcssl‘ully T lhc PW4SP Data
Management System

Section 3: the concept of the mlcrocompmer architecture and an overview ol hardware
configuralions

Section 4: fundamentals to operate the system with internal architecture
Section 5: basic concept of software operation

Section 6: a comptletc list of data files and worksheets in the PW4SP Data Management
System :

Section 7: data linkageé
Secction 8: the procedure of updating the PW4SP

Section 9: standard report format

2. SYSTEM REQUIREMENTS

The I'oliowing are the basic requirements to successfully run the PW4SP data mzinagemcm.

Hardware:

Compu_lc;-r.:
RAM:
Hard Disk:

Floppy Drive;

Monitor:
Printer:

Mouse:

Software:
Pentium Serics © Operating System: Window 95/98
~ 32 MB (mininum) : Windows Package: MS-Office 97
3 _GB {minimum) Spreadsheet: -~ . MS-Exce! 97 -
3.5inch, High Density ~ Word Processing: MS-Word 97

VGA Monitor
80 column {Can hand!e A4 size paper).
- Any brand that supported by MS-Windows

+ Miscellaneous: 508 watls Automatic Vo!tage

Regulator and Surge Protector
UPS 450 walts

2.34




o

RS MICROCOMPUTER SYSTEM

All computers, whether large or small, basically operate on the same fundamental principles. The
hardware and sofiwarc of a mainframe computer and a microcomputer have the same components

and fulfill the basic functions necessary to any computer system.

The computer is scen as a powerful too] that can enable us to expand the horizons of our knowledge.
It allows processing of large volunie of data or complex paltern of information that would otherwise

be difficult to organize and understand. Morcover, it allows for an casy manipulation of data.

There are two major components of a microcomputer: the hardware and the software. These two

components complement each other in order to fulfill their basic function.

A microcomputer hardware is made up of several components based on the {unctions they perform in

the system and how they interact with the other components.

The principal clements of a computer system are:

Central Processing Unit (CP)

Main Memory {RAM)

Secondary Storage Devices (disk, drives, magnetic tapes, cte.)
lnputv’Output Devices (monitors, printers, €tc.)

* & & *

The CPU does the actual computmg ll Is capab!e of sumple arithmetic and loglcal op-‘:ratlons such as

: addmon and dala comparison, that arc executed at cxwedmgly high speed. The power of a computcr

_dlrcctly stems from the speed and accuracy with which the CPU can carry oul camputahons and move

information arcund. The mam memory of the computer is usuaily ra,ferred to as Random Access
Memory or RAM This part of the computer contains the programs and infor mation that arc currently
bcmg processed by the CPU. Scwndary storage devlcc suchas magnellc dlsk is capablc of holding

Iarge amount of data. Programs and data are normally stored on these secondary dewccs and could

“be retneved when needed. They are then loaded into the RAM and cxccuicd The results of the

' processing can then be written into the secondary storagc de\uce or sent {0 an output device such as

the monitor or prmter Perlpheral devices or !npuUOutput (1/33) devices allow (he user o put data into
a compu!er or receive output from a computer. A terminal is a peripheral that contains both a

keyboard for input and a monitor for output. Qther périphcrals include printers and plotters.



The diagram below presents the basic hardware component of a microcomputer system.

Central Processing Unit

(CPU)
/O Terminal Sccondary Storage
A
Random Access Memory
Keyboard (RAM)
@p| Hard Disk
Monitor 1~
- | Floppy Drive
Printer < :

F!oppy Drive is lhe most conunon type secondary storage used in personal computer today. It acls as
an cxtemal drive from which’ lhe users insert the ﬂoppy dlsk to slore and retricve information. ‘The
ﬂoppy dlSl\ comes in three s:zes 3 S inches, 5.25 inches and 3 muhe‘: Itis charactenzed by thin
circular p}asnc sheels coated with iron oxide so that magnetic paltems recorded on it can be relamed
The surface is similar to a magnetic tape used to record musrc The S. 25 inches dlskeuc is contained
ina squarc cardboard envelope in which it spins. The 3.5 inches dlskeue is contained in a hard plastic
case with a metal shutter that pn}tf:cts the magnetic med:a. A ﬂopp)- disk can store from 80 kilobytes
:to 144 megabylcs of data. Floppy disk sj.rstem is slower énd has less storage capacity than _hafd disk

system but its lowcr cost makes ila popular choice for personal computer users.

Hard disk i is made of magnet:c metal, and can euher be removable or non-removable. The most
common lype of hard disk that is found in personal computer today is non-removable. This disk
typically holds from 10 megabytes to 3.2 gigabytes of information. Each megabyte is equivalent to
1,048,576 gharacters of information, or roughly 1,800 single-spaced typewriticn pages; hence, this is

a very elficicnt way to store large volume of infonnation.

Keyboard is an external devnce that acls as a primary mtcrface between the human operator and the
n.ompuler The keyboard has 3 basic components: the typewriter keyboard which is composed of
alphabet characters; the calculator pad which is composed of numeric characters; and the function

keys which serve as special iacro key for various software.




;'tloni!qr is the screen or video display peripheral and serves as the main output device on a personal
computer, It is used to display text and graphics information and is available in a variety of sizes and
types. Monitors can be divided into two broad groups: those designed to display text information; and
those designed to display graphics information, such as chaits or picture. Within the graphics group,
there are color or monochrome (single color} displays. A high quality geaphic color monitor is

capable of showing high-resolution pattern and is recommended for application in MS-Window,
Excel, or AutoCAD.

Printer is another conwon pc; ipheral l'ound in personal computer system.  The common types of
prmtr. rs are dot rmmx inkjet and Iascr prmtcr ‘The dot matrix printer produccs its image by printing
a group of dols lhat :form the image of a character or symbol. The inkjet printer is similar to the
impaét dot hiétrix prihtér, instead of using lhc pin impact force to create an image it use ik bubble to
créatc sinﬁlaf image. The inkjet printer is much ligﬁtcr ard quict than the impact dot matrix printer.
Today, it is the popular choice due to it characteristic and wide availabi.iity of selection. The laser
printer produces its image be means of électrophomgraph similar to the principle of photocopy
machine. The image produced in the faser printer is much crispier than the inkjet printer due the high-

resolution capability. Both the inkjet and laser printer can produce color print.
4. . OPERATING SYSTEM

'Operatmg systems is a set of control program that manages the computcr s resources and creales a
well-defincd soﬂwarc cnvnronmuit for computer applications, Computer hardwarc by 1!5L1f can
perform little useful work. A cdmputer requires software to be able to communicate and do useful
" work. The first la)r.r of soﬁwarc ina compu!er sysicm is the operatmg system. This'is what starts, or

_boofs tp, the machine hclps in pulling itself up by.its own bootstraps and establnshes a predetermined
. set of conditions so that applications can be run. When the computer is Iumed -on or the reset button
is pressed, the control is pass to a set of control programs found in the ROM a firmware store in
'computer chips. These programs perform several tasks: (1) to chcuk if hardwarc are funclioning
correctly; (2) to load a set of control program [rom the disk to the mcmor) and (3) to pass control to
a routine which will accept the user mput. At this point, the operating system is loaded and the user

can execute an application program such as MS-Word, Excel, Power Point, Access, ctc.

An opcrating sysiem by itselfl has two levels of functionality. The first level is seen by the user
running the applications and utilizing system commands and utifities. At thié level, each operating
system has its own set of command used to accomplish frequently performed lasks such as copying
files, renaming files, and fonnalimg disks, Normaliy, frequenlly used functions are included in the
opcrating system as system wmmands ’Ihc second is at the programmmg level. Al operatmg

systems contain a set of pre-packaged routine thal performs the “primitive” functions necessary in



almost all applications.  Such functions, like sending a character to the scicen, reading and writing
information from a disk fite, and accepting input {romn the keyboard are common to nearly all

programs. This level of functionalily gives the programmer a set of standardized routines (o perform
this task.

5, SOFTWARE

The 0permmg system alone renders the computer nearly uscless unless lhc wser is capablc of direcily
conunumcalmg to the hardware. In order to use the computer system soflware 15 needed Various
soflware are avmlahle for dlﬂemu purpos:.s such as MS-Word for \sord proccssmg, Hccl for

spreadsheet, Power Point for pruscmauon, Access for database and Foxpro for database
Prograniming.

5.1.  MS-WINDOWS

MS-Windows is the most popular operating systerﬁ, it dtap!icatés all.;he' funéﬁoh pérfonﬁed By DOS,
the defunct operating systém of the scvcnliés and eighties. The capability of MS-Window operating
system far exceeds that DOS can offer it most convenient and easy to nawgaie MO::[ of the
commands are represcnted by dcscnptwc ﬁgnres called lcons Navlgalmg around the wmdows could
be achieved through the use of a pmnung dcwce ca]led mouse, normally in the dcsktop environment,
the mouse pomtcr is seen as outline of an arrow or white arrow. To execute a command lhe user
only nced to bring the mouse pointer to the desired command described by the icon and press the right
button or double click the left button. The execution starts without typing any single character in 1he
kcyboard unhke the DOS convention that needs typing a scrles of characters comprising the
command. In wmdows lhe computer screen is refened to as the desktop When working, the
application and documents must be in the windows. The windows on the desktop must also be
arranged. Ifan apphcauon is left for a whlle thc windows are shrunk to an application icon, and still,
the applu.auon keeps running on the backgmund When an apphcauon is shrunk, the windows piacc

their appilcauon icon at the bottom edge of the desktop until it is again restored to window size.

With mndow», several powerful apphuahons can be run simultaneously. For e\cample swnta.hmg
from a word pmcessmg application to a spreadsheet, and then to database application with a few
snnple moves while quilting one application and restarting another, can easily be done.

Parts of a Windows

Each application and some documents the user choose to work on, open as separate windows. Every

window has some common elements, however, not all windows use all the items.




The elements as ittustrated below are the tools for working with the window and the application or

documenl within the window.

Con rrof‘menu Minimize
button

R Maximize
button
insertion

point

] mle bar Wndowlrtfe -
Nﬂltpml iUnmledl

e
£ite
!

Edit Seacch Help

Mouse
pointer

Window
border

RN AR

ey

Verlical
scroll bar

ST

™
i

B A

hi‘d Fai

prysy

mam.r*:::z,ww O R R ARt ¢
Wndow corner

t‘a e H"\-

Horizon!al scrolf bar

The Control-menu box located in the upper-lcﬂ comes of the window is the most useful menu when
the use of a kcyboard is prcfcrrecl The Control- -menu commands can resize, move, maximize,

minimize and close windows, and swntch to Task List.

The title bar shows the name of the applicaﬁon or document, If moré_lhan one window is open, the

title bar of the active window has a different color or intensity compared to the other title bars. -

The 'w:"ndow title, depending on the type of window it appcars, can be the name of an application and

the name of the document, or a placeholder. In such case, “untitled” normally appears.

The menu bar lists the avaitable menus. Most applications have a File mér_m, an Edit meny, and a

Help menu as well as other menus unique to the application.

- The Scroll bar can move the parts of the document into view when the entire document will not fit in
the window.- With the bar, unseen poriion of the lists and other information that is too long to fit in
the allotied space can also be viewed. . '

The Maximize and Minimize buttons enlarge the active application window to fill the entire desktop or

shrink the window to an icon. Document windows enlarge just to fill the application workspace and
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not the entire desktop. After enlarging the window, the Maximize bution changes to a Restore button,

Restore button can be used to retarn the window to its previous size.

The Window border is the outside edge of a window. It can lengthen or shorten each side of the
border. '

The Window corner can be used {o shorten or lengthen two sides of a border at the same time.

‘The Workspace is where most of the work with an application are done. For example, the content of
the documents appears in the workspace when starling a wordprocessor. Hence, an application can

allow the opening of more than one document window within this workspace.

The selection cursor shows where the user is in an individual document, 1t marks the place in the text
or graphics where the user begins typing or drawing. The arrow-shape mouse pointer appears if you

have a mousc installed. It is used to indicale items the user wants to select with mouse,

Starting Applications with the Run Command

The Run command isa handy way to start apphcauons ihat you want to ruh only occaswnally or hav
not yet added to a group. You can open a document at the same time you starl the apphcahon

Unless the program file is m your current path, you need to know the exact dm:clory location and

name of lhe progtam file before you can start the apphcahon

1. Choose Run from lhe File menu in Frogram Manager or File Managcr
- The Run dialog box appears.

2. Type the pathname and the exact filename of the program file, including the extension
if there is one. :
3. If you want the appllcatlon to shrink to an icon as so0n as ll starts, make sure the Run

Minimized check box confain an X.
4. Choose OK or press ENTER.

52. MS-EXCEL

Excel is a spreadsheet tfpe of software package that operates under the MS-WINDOWS operating
system. The primafy document in Excel is called a workbook. The workbook is similar to a ledger
that stores information and each workbook is made up of sheets. The sheet is virtually divided into
column :and row; the i:olt_lmn run horizontally and denoted by an alphabet starting with 4 and the row

run vertically and denoted by number starting from 1. The intersection of column and row is called




cell. The cell is the basic component of worksheet that accept different data types. The most

common data types are character, number, date, logical value and formula,

Standard Toolbar

The standard toolbar that normally appears at the top of screen helps select options. Such options can

open workbook, print and save wbrksheel, and ask for help. The following is a list of the individual

icons and their respective funclions.

Excel’s Standard Toolbar

Button Name Function
| D l New Workbook Creates a new workbook
Ty B
& Open Opens a document
r— :
H Save Saves the aclive workbook
l % I Print Prints the aciive workbook
& Print Preview . Shows the aclive-document in print preview mode
ABG S '
V/ Speller - Checks the spelling of the decument
(¥J Cut Cuts the selection to the Clipboard
Copy Copies the selection to the Clipboard
@ Paste Places the Clipboard contents at the insertion point |




Name 1 Function

Button

Undo ' Undoes the last action or corunand

| @ I Formal Paintcr Copies and pastes formats for cells and objects
L

o Repeat Repeats the last action or command;
this is the same as the redo feature in Word 6

e — :
2. AutoSum Inserts the SUM function and shows sum range
f._;; Function Wizard Starts the Function Wizard

Sort Ascending Sorts selected rows in ascending order

Al

Z

F Sort Descending Sorts selected rows in descending order
AN

ChariWizard Activates the ChartWizacd

Text Box Inserts text or text box

Drawing Turas the drawing toolbar on or oft

B Zoom Control Sets the view of the document

Tip Wizard Tums the TipWizard loolbar on or off




_ Buiton Name Function

l $2 I Help Displays Help

|A:ial ‘ [g Font Sets the font for the selection

[IE E Font Size Sets the font size for the selection
- Hiii—:—_ Rold Boldfaces the selection
z ftalic Ralicizes the selection
- E‘ Underline Underlines the selection
( Eg Align Ledt Left-aligns the selection
3 |
% Center Cemefs the selection
—:Eé“ Align Righi ‘ §ight-aligns the selecli;)n
E;gi .gs?;i:niﬂ_éss Ceniers the sclection across columns
‘ E | CUI.[?[;CY Style Changés the sc!cctcd.cells to default currency slyle
o] Percemt Style | o Changes the 'se!et;ted éeils to .dcfauit.pe_fcflﬂ.‘_swle
y Comma Style Changes the selected éells to default cbm_ma S‘S’fe




Button

+.0 l
00

Function

Adds one decimal place to the number format

;qg Decrease Decimal Removes one decimal place from the number format
:: » Borders Enables you to select a border for the selection
% h 4 Celor Sets the color for the selection

i
il

Font Color

Sets fhe color for the selected font

7
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Tabs Worksheet

MS-Excel Basic Operation

Following the descriplion of lhe basic operalion the mouse is used as a pointing device instead of a
' keyboard The word click means the user must press the left bulton of the mouse; double click means
two successive clicks; and enfer means the user musi prcss the Enter key in lhe keyboard Basic

operation dealt only to the routine necessary to update the PW4SP data base.

Creating a Nen Worksheel

When you enter Excel, it opens up to a new workbook, by default it contain 16 workshcets You can
use any of the worksheels. Even if there is an open workbook, you can still open another by moving

the mouse pointer in the New icon (upper left of the screen below the menu bar). Click on il

Saving the Workbook

1. Move mouse pointer to File menu and click on it to bring the File menu option.
2. From the oplion available. Select Save.



3.

If the document your saving is new. The Save As dialog box appear. In the File Name box
type the name of the workhbook.

Euter Patain a Cell

First select the cell by moving the mousc pointer and clicking the right button,

This routing place the mser(lon point in thc active cell, which is hlghhghtcd on-screen with
border around it. '

You can start cntering the data from your kcyboard or numeric keypad.

"To confirm the input, you can press ENTER or move thc mouse pointer to the Formula bar
and click the Check icon.

Editing Cell Contents

1. DdublcQCIick the cell co:itaining the data you want to edit. To edit in the formula bar, click
in the formula bar. In case the formula bar is not displayed, choose Formula Bar from the
View menu located at the top row of screen.

2, [Edit the cell contents.

3. To confirm the modification made in the ce]l chck the Check icon in the formula bar or
press I‘N ¥ bR To cancel edits, click the X icon in the formula bar or press ESC.

Clearing Cells
I. Selecta cell or 'rangc of cells that you want to clear.
2. From the Edit menu, choose Clear, and from the option available,

you the choose All, Contents, Formats, or Notes.
Shortcut Press DEI

To clear cells by dragging

1.

Select a cell or range of cells thal you want to clear.

2. Move the mouse pointer in the fill handle (lower right comer),
drag the fill handle toward the area of cell or range, then the selected
area will become gray.
3. Release the mouse button.
Copying Cells

l.

Sclect the cells contammg lhe data you want lo copy.

2. From the Edit menu, choose Copy.

3.

Select the upper-left cell of the paste area.
Beware that any values or formula in the paste area will be rcplaced

Undo Comm:_md

.

To undo your last command, click the Undo button.

" From the Edit menu, choose Undo.

(‘reatmg Border arcund Cell

Choose the Cell menu from Format menu,

2. Choose the side you want put the border, and then choose type of border.
3. Click OK button. ‘
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Deleting Rows and Cotinnns

I.  Sclect the row or colunin
To delete more than one row or column, extend ihe selection to include
all the rows or columns you want to delete.

2. From the Edit menu, choose delete (Entire rows or column)
3. Click OK bufton

Inserting Rows and Columus

1. Sclect lhc TOW Or column
To insert more than one row or column, cxtcnd the sc!ccuon to include
the mnnber of rows or columns you want to insert. -

2. From the Edit menu, choose Insert (Entire rows or column)
3. Click OK button.

Selecting a Sheet or Sheets
To sclect a single shect, click the sheet tab.
To select two or more sheets

1. Click the sheet tab for the first sheet you want 1o select,
2. If the sheets you want to select are adjacent, hold down the SHIFT key
and click the tab for the last sheel.

If the sheets you want to seleet are non-adjacent, hold down thc C IRL key
and click the other sheet tabs.

Ungroup Selected Sheels

1. Movc the mouse pomter to the sheet tab. Click the left button of the mouse.
2. While the mouse pointer still on the sheet tab, click the right button and
choose the Ungroup Sheets. :

Inserting Worksheet

I. Selecta s_hcc'l‘or sheets in the workbook.
2. From the Insert menu, choose Worksheet.

The new sheel or sheets will be inserted to the lefi of the sheet tab you select.
Shortcut : SHIFT+F11 '

Dclelmg Worksheet

‘ l. Select a sheet or sheels m the workbook.
2. Move the mouse pointer te the sheet tab, and click the right bulton
3. Choosc Delete, and click the OK button. :

Moving Worksheet Within the Workbook

1. Select the sheet or sheets you want to move. _

2. Drag the selected sheet tab along the row of tabs.
A black triangle indicates the place where the sheets will be inserted.
All selected sheets will be inserted.

3. Release the mouse button.



Altemate Method

Select the sheet or sheets you want to move,
From the Edit menn, choose Move or Copy Sheet.

In the Before Sheet box, select where you want sheets to be inserted.
Click the OK button.

Lot B =

Moving Sheets to Other Workbook

1. Open the workbooks you want to move sheets fo and fron,

2. Select the sheet or sheets you want to move.

3. From the Edit menu, choose Move or Copy Sheet.

4. In the To Book box, sclect the destination workbook. '
5. In the Before Sheet box, select where you want the sheet or sheets !ﬂSCI‘ILd
6. Ciick OK button.

Altermmative Method

I Open the w orkbooks you wanl to move sheets to'and from.
2. From Window menu, choose Arrange and choose horizontal.
In the desktop, two workbooks will open in screen split the workarea horizontally.
3. Seclect the sheet or sheets you want 1o move. :
4. Hold-dewn the CTRL. key and the right button of the mouse.
A paper icon and black triangle indicate that you made the move routine active.

5. Drag the mouse pointer to the other workbook and select where you want
the sheet or sheets inserted.

6. Release the mouse button.

Copying sheets within a workbook _ ‘ ' ' é

o

Select the sheet or sheets you want to copy. o

2. Hold down the CTRL key and mouse lefl button, and then drag the selecled
sheet tab along the row of tabs. ‘A black triangle indicates the place where
the copicd shect will be inserted.

3. Release the mouse button and then the key.

Altermative Method

Select the sheet or sheets you want o copy.

From the edit menu, choose Move or Copy Sheet.

In the Before Sheet box, select where you want the copied sheet inserted,
Select the Create A Copy check box.

Click the OK button,

COp}mg sheets to othcr workbook

Open the workbook you want to copy to and from.

Select the sheet or sheets you want to copy.

From the Edit menu, choose Move Or Copy Sheet,

In the To Book box, select the destination workbook.

In the Before Sheet box, select where you want the copied sheet inserted. _
Select the Create A Copy check box. g
Choose the OK Button.

R AR it



Printing your Work

1. From IPile meny, choose Page Setup to display the Page Setup dialog box.
2. On Page Setup dialog box, their are four option available

Page tab controls page orientation, scaling, page size, print quality, and
starting page numbcer for the selected sheet.

Margin tab controls page margins and the header and footer margins, and
center the sheet on the page vértically, horizontatly or both.

Header/Footer tab controls page the headers and footers for the selected sheet.
headera and footers are descnptwc text that print at the top and bottom of
cvery page in your sheel. You can add, delete, edit, format, and position
headers and footers, and view them as they will print.

Sheet tab specifies which arcas of the sheet you want to print, and controls
the print titles, page order, and drafl quality. Also controls whether
gridlines, cell notes, and row and column heading print. The Shect tab is
displayed if the active sheet is a worksheet or macro sheel.

3. On the Print What, their are three oplion available, :

Selection option prints only the sclected cells in the selected sheets.
Nonadjacent sclections are printed on separate pages. Selecting this
overrides any print arcas you have defined for the selected sheets using

~ Print Arca option on the Sheet tab of the Page Setup dialog box.

Selected Sheets optlon prints the arca of cach of the currently sclected sheets,
with cach print area starting on a dlﬂerenl page. [Tno prult area is dclmcd
on a separate sheet, the éntire sheet'is printed.

Entire Workbook oplion prinls the entire print area of alt sheeta in the active
workbook. IT a sheet does not have a print area, that entire sheet is printed.

. 4. On the Copies box, specifies the number of copies to print.
5.O0n the Page Range, their are two option ava;lablc
£§ All option print all the pages in the selected shcels

Pagefs) aption print the range of pages specified in the From and To boxes.
Page numbers you sclected in the From and To boxes affect which cells
will be printed, not the numbermg of the pages upon which they are
printed. To change the numbering of printed pages, specify a number in
thic First Page Number box of the Page lab in the Page Setup dialog box.

6. The user have option 1o see the appearance of the pnnt by chckmg the

Print Preview button. .

7. Printer Setup option give the user an option to select among lhc available
printer drivers.
8. Clrck thc CK button lo procued printing.

53. MS-WORD

MS-Word is word processing type of software. This is analogous of converting your compuler into
_typewriter machine. You have page in which you type characters, you have a ruler that show where
you are as you type across the page. You have tabs stops and margin seftings. 'the insettion point

moving across the page even acts like the print head moving across the page.

MS-Word offer more advance features that you need to create from simple to complex 1ype'of

9 documeni. When you start Word you will notice almost the idenlical appearance with that of MS-



Excel. Most of the command are represented in teems of icon, in the middle of the workspace were

you cnter your text and other object included in your documents.

Starting Word

From the MS-Window environment, you éayi d‘oublc-click‘the MS-Word icon in the MS-Office
program group. In some case the MS-Office administrator is automatically loaded at start-up of
Windows environment. The MS-Office administrator menu icons are located in the upper right side

of the screen. You can start MS-Word by clicking the icon.

Quiting Word

1. Meove mouse pointer to File menu and click. File sub-menu will appear.

2. From the File sub-menu, move mouse pointer to Exit option and click.
The MS-Word environment will normally terminate. In some cases, if some active
documents has not yet been save. MS-Word give the user’s option to save the documents.

Standard Too!bar

The standard toolbar whwh normally shown at the top of screen helps you select the option, from
this tootbar. F he user s can open new document, open exnstmg document print and save document
and ask help to farther understand some function or proccdure to accomphsh desired task. Usmg the
toolbar speed- -up the deswe task instead of usmg the memu (located at the top of the screen) Thc

following shows the tist of standard toolbar icons and lhclr functwn

* MS Word Standard Tooibar

Button Name Function
New Creates a new fite based on the Normal template
Open Displays the Open dialog box so that you ¢an sclect an

existing file to open

o @ @[ O

Save : Saves the current document
Print . Prints the current document
Print Preview Activates Word’s prinl preview features




Ea
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i

| Button | Mawe | . Fadton ]
t;;' Spelling Initiates a sipclling check
4% Cut Cuts selected material t; lhc ;;i;c;;\;;Clipboa;d -
B S
—_@_ Paste Pastes material from the C.Iipboard into your document
'g ‘| Format Painter Copie: the formatting of a selecl;m :;h‘ct:‘-;:y:;s)pcc“i_ l:y
h Undo Undoes the commands you select from the list [‘Jrcscmcd_
“; Redo ' ch;lo:’;s the Eonunénds Iyou select from lhé lis_t prese;;‘l )
E AutoFormat Formats yéur docutﬁém: autbmatically

Insert Auto Text

Inserts an Auto Text entry.

Insert Table

Inseits a table into your document

Insert Excel

Inserts an Excel worksheet into your document

Worksheel
Columns Formats your document using columins
£ Drawing Opens the drawing application and enables you to draw a
picture in your decument
@ tnsert Chart Inserts a chart into your document




MS-Word Basic Operation
Opening and Existiﬁg Documnent

I. Click the Open Folder icon (normally second from the left) to bring up the open
dialog box.

2. In the Open Dialog box, select the file you to open from File Name combination
box.
3. Click the OK button.

Changiﬁg the Format of the Text

1. Click the arrow button to the right of the font box to bring the list of available font.
2. Seroll through the list box by clicking on the scroll bar, and select a font by clicking
on it.

3. Bepin typmg. The text will appear in the font you Just selected.

Changing the Font Size

1. Cllck the arrow bulton to the nght of the font size box to brmg the list of avax!able size.
2. Scroll through the list box by clicking on the scroll bar, and select a size by clicking on it.
3. Begin type. The text will appear in the font size you size selected.

Choose a Style

Perform any of the following procedures to bhafﬁge a font style:

» Click on the button tabeled B to set the bold feature on.
You also can press Ctrl+B from the keyboard.

s Click on the button labeted 1 to set the italic feature on.
You also can press Ctrl+ from the keyboard.

¢ Click on the button labeled U to set the underlined fealure on.
You also can press Ctri+U from the keyboard.

¢ Click on the button labeled B and I to set both bold and italic features
You also can press Ctri+B followed by Ctrl+I from the keyboard

- Setting Speclal Effects

You can use 2 variety of special text effects:
+  Strikethrough
*  Superscript
+  Subscript

Bulton o Newme | ~ Funetion -
@::”B Zoom Control Scales your view of the document b)} the percentage you
select e
K? Help Activates context-sensitive help

O



+ Hidden
¢ Smwall caps
+ Allcaps

To set any of these features, use the following procedure:

1. Open the Format menu and sclect the Fonrt item.

2. If the Fonts tab is not on top, click on it.

3. In the Effect group box, sclect the cheek box that represent the special effect
yau want (o turn on.

4. Click the OK buiton,

5. Begin typing. Your text appears with the special cffect you selectul

Sctting the Indentation

1.

3.

Open the Fornat menu and select the Paragraph item.

If the Indents and spacing tab is not on tep. click on it.

In the indentation group box, use the Left and Right spin boxes to set the indentation

from the left and right margins. Click on the arrow butions until the measurement is correct,
or sclect the text in the body by hlghhghtmg it with thc mouse and then type exact
measurement you want.

To set first line or hanging indentation, apen the Speclal drop- down list box by

clicking on its arrow, and sclect the appropriate item. Use the By ‘spin box to sct the
measurement for the first linc indentation or the hanging indentation.

Click the OK button. Your currciit paragraph takes on the indentation you just set.

Each subscquent paragraph you create takes on this pattem, un?ess you reset the

indentation using the d:alog box

Setting me Spacmg

P man

Open thc Format menu and seleut the Paragraph item.

If the Indents and Spacing tab is not on top, click on if.

In the Spacing group box, use the Before and After spin boxes to set the distance in

points from the previous paragraph and from the followmg paragraph. Click on the arrow
buttons until the measurement is correct, or select the text in the box by hlghhghtmg it with
the mouse and then type the exact measurement you want.

To set ling spacing within the paragraph, open the Line Spacing drop down list box by
clicking on its arrow, and select the appropriate item. Then use the At spin box to set the
measurement for number of fines or distance between lines, whichever i is active.

Click the OK butten. Your current paragraph takes on the line spacing you just set.
Each subsequent paragraph you create takes on this pauem unless you resct the line spacing
using the dialog box.

(‘ opying and Inserting Text

B

Highlight the text by dragging the mouse pointer over the text to be selected.

Move pointer to Copy icon and ¢lick on it. :

Move mouse pointer to the place were you would like the insertion take place.

Move mouse pointer {o Paste icon and click on it. Alternatively, you can press the right
button of the mouse to bring the menu option., sclect the paste by click on it.

Undoing and Redoing

if you do make a mistake, you can undo it by selecting the Undo option from the Edit meau.



‘this procedure undoces the ast change you made to the document. Word always will add the name of
the operation yeu are about to undo as the second word of the Undo menu iten. I you cannot undo

anything, this option change to Can’l Undo and is dimmed.

Overstriking Text

There are times, howcvcr when you want to type over éxisting text. To switch to this editing mode,
press the Insert key in the keyboard. thn you type, the characters you type replacc any characters
to the left of the inserlion point. To tum off the overstrike mode, press the Insert key again.

Deleting Text

Use mouse pointer to highlight the desire text and press the Del key from the keyboard.

Insert File

I ’Vlm ¢ mouse pomtcr in the location were you would hke the insertion take place.
2, From the Insert menu, select File option. '

3. From the File nane combination box, select the file you would like to insert.
Click the OK button. :

Creating thc Iieader or Footer

1. From lhc Vrew menu, choose Header and Footcr
2. The Header and Footer toolbar appear, click the switch between Hcader

and Foofer button. The header and footer arcas arc enclosed by a nonprmimg @ )
dashed line.

3. Do one or more of the followmg, : - :
Text - You can fype the text within the dashed line ihal surround lhe header or fooler area.
Page Number - Click the icon. :
Current Date - Click the icon.
- Curent Time - Click the icon.

4. To retumn to the document, choose the Close button on the }[eader and Footer toolbar or
double-click lhe main text arca

Previewing lhe Documenl

1. From the Flle menu choose Pnnt Prevnew
While in the print prevucw mode, you can perform the followmg options.
~ a) You can print the document by click the Print butten.
b} You can switch the magnifier on and off by clicking on the magnifier button.
* ¢) You can switch to a one page view by clicking the One Page button.
d} You can switch to view multiple pages by clicking on the Multiple
~Pages Button and dragging across the grid that appears, releasing the
mouse button when you have the multiple-page view you want to use.
€} You can zoom in or out on your document by adjusting the zoom
perceniage in the Zoom Control drop-down list box.
f) You can switch the view of the ruler on and off by clicking on the
View Ruler button. Q
£) You can squeeze a small amount of text on the final page into the
the outer pages by clicking on the Shrink to Fit button.



h) You can expand the preview screen to show only the page, the
toolbar, and the status bar ¢licking on the Full Screen button.
1) You can exit the preview mode by ¢licking on the Close buiton.

Printing your Document

1. From the File menu, choose Print option.
A Print dialog box appear.

2. In the Print What drop-down list box. This oplion enables you to print the
document or several items ancillary to the docament, stich as Summary Info,
Annolation, Siyle, Autotext Enlrics, and Key Assignmeats.

3. Use the Copies box to enter the number of copies to print.

4. Use the Page Range oplion to determine how much of the document to print.
You can print All the documem, the Current Page, or selected Pages.

5. Check the Collate Copies check box fo finish the fi rqt set of copy before
printing the sccond copy.

6. When all it set correctly, close all the dlalog boxes you havc open,
and click OK bulton, the printing process begin.

6. PW4SP DATA FILES

Data files are collection of information relevant to the preparation of PW4SP. Data files are logically
group into three major arcas of information. The first group of info’rmatibn are the base data that are
composed of information derived from survey, d_éular inspection, and cxisting information from the
provincial and national agencies. ."l"'hc second group of informalion are ihe key parameter data that arc
composed of information derived from apphcable policies, assumptmn waler test result, and curvent
cost of commodity. The third group of information are the presentation of data which derived from
the prcwou%ly mentioned groups of information’ s, ﬂns data are processed and then loglcally arranged
to show provincial profile, existing famllties and servace coveragc past financial performance, future

n.qmremenl of the relevant sector, cost estimates for future sector deselopmcnl and financial

arrangcmcnl

‘6.1 . Basc Informalion

1. Soc:o—ecanomtc Data (Socm economic.xis)

a) Mumcnpal/C:ty Status and No. of Barangays ( Muncny Status (P.1.1Y)
b) Past Population ( Past Population (P.1.2.1) & {(P.1.2.2) ) , :
¢} Projected Population ( Projected Population (P.1.3.1) & (P 1.3.2) )

d) Houschold { Household) (P.1.4})

" e) Services ( Services (P.1.5)) =
f) Occupation { Occupation (P.1.6))

2} Family Income { Family Income (P.1.7) )
h) Expenditure ( Expenditure (P.1.8) }
i) Education { Education (P.1.9))

2. Land Use Data (1.anduse xls)
a)} Existing Land Use { Existing Land Use (P.1.2.1})



b) Futire Land Use ( Futere Land Use (P.2.2))

3. Health Data (1{calth.xls)

a) Morbidity, Mortahty and Infant Mortality { Morbidity and Movtality (*.3.1) )
b) Facility ( Facility (P.3.2))

¢) Practitioner (Practitioner (P.2.2))

4. Water Resonrce Data (Watcr Source.xls)

a) General Information ( Gen, Info (P.4.1) )
b) Water Source Information ( Source Info (P.4.2) )

5. Water Supply Sj‘slemé Dafa (Wéter Silpply.xls) -

a) lcw!l[‘acmty(le\el I(PS l))
b) Level Il System ( Level H (S.5.2. l)&(8522)) _ '
¢) Level Il System { Level T11(8.5.3.1), (§.5.3.2), (§.5.3.3) & (S.5.3.4) )

6. Environmental Sanitation Dafa (Sanitation.xls)

a) Houschold Toilets { Houschold Toilets (P.6.1) )

b) School & Student ( School&Student (P.6.2) )

¢) School Toilet (School Toilet (P.6.3) )

d)} Public Toilet { Public Toilet (P.6.4.1), (P.6.4.2) & (P.6.4.3))
¢) Drainage Facility { Drainage Facility (P.6.5))

f) Solid Waste Col!echon and D:sposai ( (M) Solid Waste)}

- 7. fmes!menr Data (!nvestmenl xls). ' ‘ S c : g

a)y . Income & Expenditure (P1.1)
b) PastIRA(P.7.2) L

¢) Available Funds for Capital Expend:lure (P 7 3)

d) Sector Previous Investment (P.7.4)

¢) Sector Allocation in the AIP (P.7.5) -

f) Allocation of the 20% Dev. Fund (P.7.6)

g) Financial Indicator of WD (P.7.7)

h) Loan Status of WD (P.7.8)

i) Affordability in Water & Sanitation Services (£.7.9)

Key Parameter

1. Key Pm amelers (Key Parameier xls)

a) I(cy Parameler (Key Parameicr)
b) Level I - Safe and Unsafe (Level I Safe and Unsafe)

¢) Well Source Composition (Well Source Composition)
&) Unit Cost (Unit Cost)

¢) Scoring Factor (Scoring Factor)
1) Annual Investment {Annual Investment)

Data Presentation g

1. Provincial Profile {(chapter-3.xls)



a) Ouwtline of City and Municipalities (MTable 3.1.1)
b) Cumrent Land Use (MTable 3.2.1)
¢) Drainage Arcas and Flow Rates of Major Rivers (MTable 3.2.2)
d) Disteibution of Hlouscholds by Income Class (MFigure 3.3.1)
¢) Population Distribution by Oecupation (Figure 3.3.2)
f) Population Distribution by Highest Attainment of Education (MFigure 3.3.3)
g) Provincial Outline on Public Services (MTable 3.3.1) :
h) Public Facilitics and Seyvices by Municipality (M Table 3.3.2)
i) Previous Population Development of the Province (MFigure 3.4.1)
j) Previous Population Development by Municipatity (MTable 3.4.1)
k) Present Population Distnibution (MFigure 3.4.2) -
1) Qutline of Urban and Rural Arcas in the Province (M'Table 3.4.2)
m) Houschold Numbers and Houschold Sizes (MTable 3.4.3)
n} Number and Rates of Ten Leadmg Causes of Morbidity,
Mortality and Infant Mortality (MTab!c 35.1)
o) Reported Cases and Deaths of Notifiable Water Related Diseases (MTable 3.5.2)
p) Municipal Selid Waste Collection and Disposal, and
Service Coverage.in 1994 (MTablc 3.6:0)
q) Number and Ratio of Popitlation to Health Facilitics
and/or Medical Practitioners (STable 3.5.1)
t) Types of Drainage Facilitics (STable 3.6.1)
s} DENR Water Quality Criteria/Water Usage and C lasssﬁcahon
for Fresh Water (S Fable 3. 6 2)

2. Existing Faahnes and Senzce (‘memge (chapler 4. xls)

a) lnformauon on [lesung Level 111 Systems (MTabie 4.1, 2)
b) Information on Water Dlstrlct (MTable 4,13}
; c) Information on Emstmg Levcl H Systems (MTabIe 4.1.4)
: d) Information on Existing Level I Facilities (MTable 4.1.5)
- ¢) Water Supply Service Coverage by Municipality in 1994 (M I’ able 4.1.7)
1) Water Supply Service Coverage by Municipality (MFigure 4.1.1) '
g) Sanitation Faq::httes and Serwcc of Household To:lcts Urban and
- Rural, 1994 (M Fable 4.2.1)
h) Provincial Service Coverage of Household Tmlcl l‘acmtles 1994 (MI igure 4.2.1)
1} School Toilet Facilities and Service Coverage in 1994 (MTablc 4.2.2)
1) Public Toilet Facilities and Scrwce Coverage in 1994 (MTable 4.2.3)
k) Details on Existing Level I Systems (STab]e 4.1.1 Sheet 1 to 4)
1) Details on Existing Level 1 System (STable 4.1.2 Sheet 1 to 6)
m) Number of Levet 1 Facilities by Safe and Unisafe Classification (ST able 4.14)
n) Estimation of Unserved Population by Municipality (STable 4.1.5)
o) Estimation of Population Covered by Safe and Unsafe Source
by Municipality (S'Table 4.1.6 Sheet 1to 2)
p) Sanitation Facilities and Service Coverage of Household Toﬂcts
- by Type, by Municipality, Urban and Rural, 1994 (STable 4.2.1) |

3) Past Financial Performance in Water Supply and Sanitation (chapter-6.xls)

3) Actual Income and Expenditures, (MTable 6.2.1)

b) Intemal Revenue Allotment to the Province {(MTable 6.2.2)

¢) Allotted Funds for Capital Expenditures (20% DF) (MTable 6.2.3)
% d) Actual Amount of Sector Investment to the Province by Concerned Agencies
: (MTable 6.3.1)

€) Annual Investment Plan 1995- 1999 (MTable 6. 3 .2)

f) Sector Allocation in the Annual Investment Plan (MTable 6.3. 3)



g} Allocation of the 20% Developmient Fund (MTable 6.3.4)

h) Tinancial Indicators of Provincial/Municipal Watuworl\s in the
Pravince (MTablc6.4.1) '

i} FLoan Status of Prowncnalﬂ\{ummpw’t Watcrworks (M1 ablc 6.4.2)

1} Affordability in Water Supply and Sanitation Services (Mtab'c 0.6.1) (\‘

X} Income and Expenditure (STable 6.2.1) -

1 Past Internal Revenue Allotment for the Provmcc (STablc 6.2.2)

4) Water Source De-.e!apmen! (chaptcr 7.x1s)

a) Existing Groundwater Sources in the Province (MTabIe 7.1.10)
b) Work Flow of Groundwater Avallablhty Map (SFigure 7.3.1)
¢) Existing Spring Sources by Municipality (STable 7.4.1)

d) River Information and Related Data (STable 7.5.1)

¢€) Water Quality Analysis Results (STable 7.5.2)

1) Existing Well Sources (STable 7.6.1)

g) Standard Specnﬁcation of Wells by Munlclpahly (STablc 7.6. 2)

3) Future Requirement in Water Supp{v m:d Sanim!ion Eriv:'r-o:r:rre:rr {chapter-8.xls)

1} Provincial Sector Targets (MTable 8.2.1)
2) Base Year Scrvice Coverage of Water Supply (MTable 8 2. 2)
1) Base Year Scmcc Coverage of Household Toilets (MTable 8.2 3)
4) Base Year Service Coverage of Public School Toilets and
Public Toilets (MTable 8.2.4)
5) Base Year Service Coverage of Mummpai Solid Was{e System in 1994
(Mi‘abicSZS) AR ‘ , . :
6) Regional Population Project (MTab]e 8.3. l) S N (
7) Municipal/City Populahon Projection (MTable 8.3.2) _
8) Municipal/City Popilation for the Year 2010 & Growih Rates (MTable 83. 3}
9) Past and Projected Population by Current Municipality/City (MTable 8.3.4)
10) Past and Projected Population by Urban and Rural Area of Current
Municipality/City (MTable 8.3.5)
11) Projected Public School Enrollmen! and Number of Public Ul;hty 3
by Municipality (MTablc 8.3.6)
12) Population to be Served by Target Year (Water Supply) (MTable 8 5. l)
13) Additional Number of Households to be Scrved by Target Year
' {Houschold Tozlcls) (M'l able 8.5.2)
14} Additional Number of Public Schoo! Student to be Served by
~ Target Year (School Foilets) (MTable 8.5.3)
15) Additional Number of Public Utilities with Sanitary Toilets
by Target Year (MTable 8.5.4) :
16) Population to be Served by Urban Sewerage in Phase 11 (MT able 8.5.5)
17) Additional Number of Urban Households to be Served by
Municipat Solid Waste System in Phase T (MTable 8.5. 6)
18) Water Supply Facilities Required by Target Year (MTable 8. 6.1)
19) Sanitation Facilities Required by Target Year (MTable 8.6, 2)
20) Number of Garbage Collection Trucks Required in Phase 1 (MTable 8.6.3)
21) Estimation of Base Year Service Coverage of Water Supply (STable 8.2.1)
22) Population Coverage in Phase 1 Provided by Served Population
*in the Base Year (STable 8.2.2) g
23) Number of Houscholds Served by Sanitary Toilets in the '
Base Year (1994)(STable 8.2.3)
24) Number of Public Schoo! Student Served by School Tailets in the



Base Year (STable 8.2.4)
25) Number of Public Utilitics with Sanitary Toilets in the
Base Year (1994) (STable 8.2.5)
26) Houscholds Coverage in Phasc 1 Provided by Fxlstmg Facilitics in the
Base Year {(Houschold Toilets) (STable 8.2.6)
27) Public School and Public Coverage in Phasce 1 Provided by
Existing Facilitics in the Base Year (STable 8.2.7)
28) Census Popidation and Prejected Population (STable 8.3.3)
29) Municipal/City Population Projection (STable 8.3.4)
30) Municipal/City Population for the Year 2010 and l“si:ma!c
Growth Rates (STable 8.3.5) . -
31) Past and Projected Populauon by Current Mumcnpahly.’Cny (S’l"tb!e 8.3.6)
32) Past Poputation Development by . Urban and Rural Area (STable 8.3.7)
33) Population Projected by. Urban and Rural Arca (STable 8.3.8)
34) Past and Projected Popualation by Urban and Rura! Ar¢a of Current
Mumc;pahlyl(,uy (STable 83.9) - :
35) Projectcd School Envollment by Mumcupaluy by Targct Year (STable 8.3.6)
36) Projected Number of Public Utilitics by Municipality by Target Year (STable 8.3.7)
37) Population to be Served by Ievel 1l System in Phase 1 (STable 8.5.1)
38) Population to be Served in Phase | (Water Supply) (STauble 8.5.2)
39) Population to be Served in Phase IT (Water Supply) (STable 8.5.3)
40} Additional Number of Households to be Served in
Phase I {(Houschiold Toilets)- (STable 8.5.4)
41) Additional Number of Houscholds to be Served in
Phase I (Household Toilets) (STable 8.5.5)
42) Additional Number of Public School Students to be Served in
Phase I and {1 (Sc‘noo} Tollcts) {(STable 8.5.0) o
43) Additional Number of Public Uuhucs wnh Samtary Tcnlets in
Phase | and II (8 Tablc 8. STy L
44) Urban Water Supply Facilities Requ:red by Target Year (bTable 8. 6 l)
45) Plan for Expansion, of E:ustmg L.eve! 111 Systein (STable 8.6.2).
46) Rural Water Supply Facilities Required by Target Year (STable 8. 6. 3)(3}
47) Rural Water Supply Facilitics Required by Target Year (STable 8.6.3)(b)

~48) Urban Household Toilets Required by Target Year (STable 8.6.4)

49) Rural Household Toilet Required by Target Year (STablc 8.0. S)
50) Public School Toilets Required by Target Year (STable 8.6.6)
51) Public Teilets Required by Targel Year (STable 8.6.7)

6) Cost Estimates for Future Sector Development (clﬂaptef-l().xis) -

@) Price of Major Materials by Facilities (MTable 10.2.1)
b) Construction Cost of Water Supply Facilities Required for

Phase 1 (2003) (MTable 16.3.1}

" ¢) Breakdown of Community Development and Training Cost (MTable 10 4, 1}

d) Unit Cost of Level ¥ {Gravel Packed Deep Well — 40m Depth) (STable 10.2.2a)

e) Unit Cost of Level I (Natural Gravel Packed Deep Well-40m Dcplh)(%’l‘ able
10.2.2b)

f) Unit Cost of Level | (Gravel Packed Deep Well - SOm Depth} (S fable 10.2.3. a)

g) Unit Cost of Level 1 (Natural Gravel Packed Deep Well-80m Depth)(S I'able
10.2.3.b) .

h) Unit Cost of Level [ (Gravel Packed Deep Well - 120 Deplh) (STable 10. 2. 4)

i} Unit Cost of Level I(Natural Gravel Packed Deep Well-120m Depth)(STable
10.2.4.5) ' ‘

3)  Unii Cosi ofLe\.ei 1 (Deep Well Rehabilitation ) (8Table 10.2.5)



k) Unit Cost of Level T (Shallow Well - 18m Depth) (STable 10.2.6)

) Unit Cost of Level I (Spring Development) {(STabte 10.2,7)

m) Unit Cost of Level 11 {600 Scrvice Population) (STable 10.2.8)

n)  Unit Cost of Level T (5,000 Scrvice Population) {STable 10.2.9)

o} Unit Cost of Level 111 (10000 Service Populaiion) (STable 10.2.10)

p) Unit Cost of Level 111 (13,000 Service Population) STable 10.2.1 1))

q) Unit Cost of Flush Water Sealcd with Septic Tank Toitet (STable 10.2. 12)
1) Unit Cost of Pour Flush with Double Pit Lawine (STable 10.2.13)

s) Unit Construction Cot of Vennlated 1mprovc Pit Latrine (STable 10.2.14)
()} Unit Construction Cost of Pit Latrine (STable 10.2.15)

u) Unit Cost of School Toilet {STable 10.2. 16)

v) Unit Cost of Public Toilet (STable 10.2.17) -

w) Costof New Laboratory (STable 10.2.18)

x) Costof Upgrading Laboratory (STable 10.2.19) '

y) Construction Cost of Water Supply Facililies Réquired for Phase 11 (STable 10.3.2)
) Cost of Sanitation Facilitics Required for Phase I (STable 10.3.3)

aa) Cost of Sanitation Facilitics Required for Phase IT (STable 10.3.4)

7y Financial Arrangements (chap-1 l.')‘(‘lsl)' -

a) Pro;ccted lntemal Rcvenue Al!olment for Mcdwm-Tcnn
Sector DcveIOpment (MTable 112, 1) '

b) Projected Allotment of IRA to the Relevant Sector by -
Componenl 1996-2000 (MTable 11.2.2) : '

¢) Financing Requirements by Sector Component for the Province (MTa’olc 11.3.1)

d) Additional Fund Requirement for Medium-Term Plan (MTable 11.3.2) -

e) Internal Rcvenue Allotment for Water Supply and Sanitation Sector { :
by Mumcrpal:ty (Mcdlum-Tenn Development 1996-2000) (MTable 11.3.3)

f) Relationship between Funding Levels and Percent of Coverage
for Water Supply Sector (MFigure 11,4.1)

g) Relationship between Funding Levels and Pcrcent of Lmerage
- for Sanitation Sector (thurc 11,4.2) . o

h) Municipal Investment Need Ranking for Urban Water Supp]y (MTable l 1.4.1)

i) Distribution of Provincial IRA to Municipality for
Urban Wati.r Supply (MTable 11.4.2) -

) Municipal Investment Need Ranking (MTable 11.4.3)

k) Percentages for Annual Investment (STable 11.3.1)

1) Comprehenswe Investmeént Need Rankmg of the Mumc;pahhcs (STable H 4.1

m) New Cost Sharing Arrangement Between NG and LGUs (MTable 11.5.1)

n) GOP-Assisted Level I Water Supply and Sanitation Project Cost (MTable 11.5.2)

o) Cost Sharmg for the Project 9Case 1): 1997 Price Level (MTable 11.5. KR

p) Cost Sharing for the Project (Case 2): {MTable 11.5. 4)

q) Available IRA for GOP-Assisted Level | Water Supply and Sanitation Project for
Eligible Municipalities (STable 11.5.1)

© 1) Available IRA for GOP-Assisted Urban Sanitation Project for Eligible

‘Municipalities (STable 11.5.2)

s) Total Available IRA for GOP-Assisted Level I Water Supply and Santtation
Project (STable 11.5.3)

- 1) Investment Program of GOP-Assisted Level ] Water Supply and Samlaimn

Project (STable 11.6.1) ‘ g

u} Q&M Cost for Level I Facilitics (STable 11.6.2)

v) Q&M Cost per HH/Month by Facility and Proportion to Monthly Family
Income (STable 11.6.3)



w) l*‘mnily Income (STable 11.6.4) .
x) O&M Cost for Rural Sanitation (8Table 11.6.5)
y) O&M Cost for Urban Sanitation {(STablc 11.6.6)

7. DATA FILES LINKAGES

Linkages arc logical connection between records in the data files. Through linkages, once the user’s
updates the source daté, all data in the streams of Ii_nkagf:s are dynamically updated. Linkages arc the
convenient tools of updating related data, these also shicld the user’s from Ihe complexity of fornmula
manipuiation. With the aid of the data anages the user’s can concentrate more in vatidating the

source data,

The following table lists the togical conneclions for each worksheel. -
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